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ECA Author Guidelines 

Everyday Learning Series 

(EDL) 
Writers for the Everyday Learning Series are 

expected to conform to the guidelines below. 

Please read these guidelines thoroughly 

before you begin writing. 

Target audience 
The Everyday Learning Series is produced for 

students and beginning educators in the early 

childhood education and care (ECEC) sector. It 

focuses on issues relating to children’s 

learning and development from birth to eight 

years. 

Word count 
Maximum length of manuscript (including 

references) is 3,000 words. Please write the 

accurate word count at the beginning of the 

document. Manuscripts over the word limit 

will be returned. Please aim to write under 

the limit to allow for editing changes. 

Deadlines 
For commissioned manuscripts, authors will 

be provided with an approximate production 

schedule to complete drafts by specified 

deadlines (this schedule will include the 

writing of a Fact Sheet for parents/carers, due 

after finalisation of the manuscript). It is the 

responsibility of the authors to inform the 

Publishing Editor as soon as possible if they 

cannot meet the agreed deadlines. 

If the author supplies a commissioned 

manuscript after the agreed deadline, it may 

be published at a later date or rejected. Non-

commissioned manuscripts, submitted 

without prior arrangement with the ECA 

Publications and Production team, will be 

subject to internal selection processes and 

may or may not be accepted for publication. 

Authors will be informed of either outcome as 

soon as possible. 

Writing style 
Please ensure when writing for the series that 

your manuscript: 

 uses an expository writing style 

 shows clear links to a broad range of 

national and international research  

 has applicability for educators working 

with children aged birth to eight years, 

unless specified (birth to three or three 

to eight) 

 is easily readable and uses plain English 

(please see next page to learn how to 

check readability and reading-ease 

score statistics) 

 does not use jargon and is not 

academic in tone 

 has minimal references (no more than 

10) 

 targets people working with or caring 

for children from birth to eight years 

 is evidence-based but assumes no prior 

knowledge of the topic among readers 

 defines new terms when they are 

introduced and uses the same term 

throughout the document 

 uses examples, i.e. tells ‘true stories’ 

 includes two to four case studies  

 provides strategies for solving problems 

 provides a minimum of six reflective 

questions across different sections  

 includes additional resources for 

further reading 

 has cross-cultural appeal and is 

culturally sensitive 

 includes concise subheadings. 

 

Manuscripts will be edited to conform to 

ECA’s in-house style and register. Edits may 

http://www.umich.edu/~exppro/info.html#what
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be substantial or minor, depending on the 

quality of the manuscript. It is advised that 

authors read recent copies of the series to 

familiarise themselves with the expected 

writing style. Edited versions will not be 

published without the author’s written 

consent. 

ECA style requirements 
The current Australian Government Style 

Manual (https://www.stylemanual.gov.au/) is 

the basis for ECA’s house style. Its use allows 

for uniformity of spellings, punctuation, 

formatting, etc. in all our publications. Some 

instances may require divergence, but they 

are treated on an individual basis. Macquarie 

Dictionary is the accepted dictionary of ECA 

publications. Authors must follow these 

reference works. 

Readability  

Language  

ECA expects the authors to write their 

manuscripts in a way that makes the concept 

and language accessible to different reading 

levels. The Flesch reading-ease score of your 

manuscript must be no lower than 40. 

Revisions will be required if the reading-ease 

score is outside this range. Take the following 

steps to check the reading-ease score of your 

manuscript within MS Word: 

 Windows 

o Go to File > Options. 

o Select Proofing. Under When 

correcting spelling and grammar in 

Word, make sure the Check grammar 

with spelling check box is selected. 

o Select Show readability statistics. 

o After you enable this feature, open a 

file that you want to check, and check 

the spelling by pressing F7 or going to 

Review > Spelling & Grammar. When 

Word finishes checking the spelling and 

grammar, it displays information about 

the reading level of the document. 

 MacOS 

o On the Word menu, click Preferences 

(you must have a document open to see 

preferences). 

o Under Authoring and Proofing Tools, 

click Spelling and Grammar. Under 

Grammar, select the Check grammar 

with spelling check box. 

o Select the Show readability statistics 

check box, and close the Spelling & 

Grammar dialog box. 

o On the Tools menu, point to Spelling 

and Grammar and click Spelling & 

Grammar (after Word finishes checking 

spelling and grammar, it displays 

information about the reading level of 

the document). 

Note: Regardless of the operating system, you 

must correct or ignore all errors before the 

readability statistics will display. 

You may also use external readability tools to 

assess the reading level of your document: 

https://readable.com/  

Terminology 

ECA prefers to use non-stereotyped language 

and situations in its publications, i.e. authors 

should avoid the use of sexist, ageist or racist 

terminology. For example, use ‘firefighter’ 

rather than ‘fireman’. In describing work in 

the early childhood sector, use general terms 

to ensure broad application, e.g. ‘parents and 

carers’, ‘settings’, ‘practitioners’, ‘early 

childhood educators’ (not ‘teacher’, unless 

specifically applicable), ‘the adult working 

with the children’, ‘early childhood 

professionals’, ‘early childhood service’. For 

more information, consult ECA’s free 

publication, ‘How to talk about early 

https://www.stylemanual.gov.au/
https://readable.com/
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childhood education and care’ 

(http://www.earlychildhoodaustralia.org.au/

wp-content/uploads/2021/07/How-to-talk-

about-ECEC.pdf).  

Numbers and figures 
The use of metric measurement is the 

accepted form of measurement in ECA 

publications. Words should be used when 

expressing numbers from zero to nine, 

inclusive. (This form may have to be varied to 

make a particular mathematical point, e.g. 

where the item being described is normally 

represented arithmetically: 4 + 2 + 12 children 

= our group of 18 children.) 

Figures rather than words should be used in 

the following examples: 

Sum of money: $5.08 or 25c, $2,000, 

$10,000  

Time of day: 10.30 am, 50 minutes, eleven 

o’clock  

Date: 14 September 1994 (day, month, 

year)  

Mass: 250 t, 120 kg, 50 g 

Measure: 56 litres, 25 mL, 26 km, 25 cm, 

16 mm 

Inclination: (degrees): angle of 45 degrees 

or 45° 

Temperature: 35°C 

Percentage: 9% (numeral followed by 

percentage sign is the preferred style of 

expression in text) 

Age: 60 years old, an eight-year-old, five- 

to six-year-old children  

 

The use of metric measurement is the 

accepted form of measurement in ECA 

publications. 

Formatting 
Manuscripts should have minimal formatting 

and indication should be clearly given for the 

placement of tables, graphs and charts. If it is 

necessary to include a table, use the table 

function of your software. Use of dot points is 

encouraged where possible, to break up the 

text. Please mark headings, subheadings and 

paragraphs clearly. For example: 

Heading level 1  
(Bold, size 16, only the first letter is 

capitalised) 

 

Heading Level 2 
(Bold, size 14, only the first letter is 

capitalised) 

 

Heading Level 3 

(Bold, italic, size 12, only the first letter is 

capitalised) 

 

Heading Level 4 

(Italic, size 11, only the first letter is 

capitalised) 

 

Use plain text in your document—the only 

formatting permitted is discussed in the 

points below: 

 Only use one space after full stops, 

commas, colons and semicolons. 

 Only use one line space between 

paragraphs. 

 Only use single spacing between 

words in the text. 

 Only use italics to indicate emphasis 

or names of publications. 

 Use single ‘smart quotes’. 

 

It is very important to conform to these 

guidelines. Manuscripts that do not follow 

these guidelines will be returned to authors 

and may miss publication deadlines. 

 

http://www.earlychildhoodaustralia.org.au/wp-content/uploads/2021/07/How-to-talk-about-ECEC.pdf
http://www.earlychildhoodaustralia.org.au/wp-content/uploads/2021/07/How-to-talk-about-ECEC.pdf
http://www.earlychildhoodaustralia.org.au/wp-content/uploads/2021/07/How-to-talk-about-ECEC.pdf
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References 
APA 7th style referencing is used in EDL; 

please see https://apastyle.apa.org/. 

In the body of the text, reference should 

be made only to the author/s and the 

year of publication (Johnson & Johnson, 

1992), or Johnson and Johnson (1992). If a 

direct quote is cited, a page number 

should be added (Johnson & Johnson, 

1992, p. 139), or Johnson and Johnson 

(1992, p. 139).  

The Everyday Learning Series is not an 

academic text, so please keep references to a 

minimum (five to 10 references). But do 

include a separate list of recommended 

resources—key works in the ECEC sector 

and/or further reading. 

Please list all references and resources at the 

end of the manuscript in the following 

formats: 

From a book 

Dorn, L. R., & Ryrerson, D. (1984). Elements of 

a healthy childhood (2nd ed.). Macmillan. 

From a journal 

Scott, I. (1992). Home injury to children. 

Australian Journal of Early Childhood, 17(3), 

18–24. 

From the internet 

Center on the Developing Child. (2018). Brain 

architecture.  Harvard University. 

https://developingchild.harvard.edu/science/

key-concepts/brain-architecture. 

Acronyms 
When using an acronym or initialism, the first 

occurrence must be spelt in full with the 

acronym/initialism quoted in parentheses, e.g. Early 

Childhood Australia (ECA). Subsequent occurrences 

should use the initialism. 

Photographs/illustrations 
If photographs/illustrations are supplied by 

ECA, ownership and copyright will be retained 

by ECA. 

We encourage authors to supply their own 

illustrations and photographs. Authors are 

responsible for ensuring that ECA receives a 

Photograph Permission Form signed by the 

parents of children appearing in any supplied 

photographs, as well as approval from the 

photographer to use the photo, before 

publication.  

Permission forms can be obtained from the 

Publications and Production team. Required 

format is minimum 300 dpi resolution in tiff or 

jpeg file format. Email images separately—do 

not embed them into the manuscript. ECA 

retains the right to omit the use of author-

supplied photographs if they do not meet the 

required printing standards noted above. 

Form of submission 
Please email the commissioned manuscript to 

the publishing editor. Unsolicited manuscripts 

can be emailed to 

publishing@earlychildhood.org.au. 

Manuscripts should include page numbering 

and a running header. Microsoft Word (doc) 

is the preferred format. If using other 

formats, please specify the software used, or 

contact the Publications and Production team 

before submission. 

Publication process 
All manuscripts are subject to internal reviews 

as well as external blind reviews. Authors will 

be notified on receipt of their work and 

advised of reviewers’ comments within six 

months. Manuscripts being considered for 

publication will often undergo numerous 

drafts before being accepted. Authors will 

https://apastyle.apa.org/
https://developingchild.harvard.edu/science/key-concepts/brain-architecture
https://developingchild.harvard.edu/science/key-concepts/brain-architecture
http://theage.com.au/news/agenews/phstole.html
mailto:publishing@earlychildhood.org.au
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have every opportunity to make changes up 

to the design and layout stage. Authors will be 

sent a draft layout for approval, and they will 

be allowed to make minor changes and 

comment on the layout. Major editing at this 

stage will not be accepted. Any concerns over 

and above a reasonable level* of final editing 

must be discussed with the publishing editor. 

*A ‘reasonable’ level of editing is determined as 

that which does not have a dramatic effect on the 

layout. 

Final authority for approval of changes rests 

with ECA and the Publications Advisory Group. 

All authors will receive a maximum payment 

of $750 (exc. GST) after publication and one 

(1) complimentary copy of their book at the 

time of distribution. (If there is more than 

one author, payment will be split accordingly.) 

Title and cover design 
The final title of the publication will 

be negotiated with ECA to ensure its 

appeal to the target market. 

Fact sheet 
Once the title is finalised for publication, the 

authors will be required to submit a two-

page (approximately 700–800 words) fact 

sheet, adapted from the title for parents and 

carers of children who use early childhood 

education and care services. In other words, 

the fact sheet will be from the parents’ 

perspective, as opposed to the educators’ 

perspective. A sample fact sheet will be 

provided to authors for reference. 

Assignment of copyright—

Author license agreement forms 
Author license agreement forms will be sent 

to authors on acceptance of the final 

manuscript, illustrations and photographs (if 

used) to show assignment of copyright prior 

to publishing. These must be signed, 

completed and returned to the publishing 

editor before publication. 

Further enquiries 
Please contact the ECA Publications and 

Production team at the earliest possible stage 

if you have any queries about ECA processes 

regarding the publication of your manuscript. 

Contact details 
Everyday Learning Series 

Early Childhood Australia 

Publications and Production 

Address: PO Box 86, Deakin West, ACT 2600 

Tel: (02) 6242 1800  

Email: publishing@earlychildhood.org.au  

Website: www.earlychildhoodaustralia.org.au 

 

 

 

mailto:publishing@earlychildhood.org.au
http://www.earlychildhoodaustralia.org.au/

